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Introduction
The Switchboard Application is an optional receptionist/operator console software
application for 8x8 Virtual Office that will increase the efficiency of your organization
with better phone call management. Switchboard allows:

» Multiple call viewing and handling

» Direct transfer to extension’s Voicemail

» Supervised call transfers

» View of extensions’ status

The Virtual Office switchboard is flexible and easy-to-use. It does not require advanced
computer applications knowledge or experience. With a few clicks of a PC's mouse,
a receptionist can transfer a call, put a caller on hold and announce the caller to an
intended recipient or search the organization’s directory.

System Requirements
To operate your switchboard, you must have the following requirements on your
computer:

Windows 98, NT, 2000 or XP operating system

128 MB of RAM

200 MB of free disk space

10/100 Base-T Ethernet connection

Getting Started

Upon subscribing to the Switchboard application, you will be provided a link to the
software within your confirmation letter. The confirmation letter also provides
step-by-step download and installation instructions to guide you through the
Switchboard installation process.

Installation

The Switchboard application must be installed on the local computers that will be
using the Switchboard Application before the Switchboard will work. Additional
concurrent Switchboard subscription licenses must purchased for any additional
number of con-current Switchboard sessions that will be run on different computers.
A user can install Switchboard on several computers and share one subscription
license as long as only one concurrent session is running. Follow the instructions to
install and set up the Switchboard Application.
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Using Switchboard

To run the Switchboard application follow the instructions below:

Double-click on the Switchboard icon.

Your user login screen will appear.

Switchboard Login @

Please enter login and passwords

Switchhoard Password :I

Image 1: Switchboard Login Box
On-Screen Organization
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ge 2: The Switchboard Interface Screen

Window Display

The Switchboard window display is divided into three main areas:

Active Calls Area
» Use this section for call viewing and:
- Answering
- Holding
- Ending
- Transferring
- Announcing
- Directing to Voicemail

Within the Active Calls Area is the “directed hold” column, a place for the operator
to see the current status of the calls in progress.
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Firstname | Lasiname Ext Status

ess (C) VoiceMail (... 500 (C)

A

ccounts  Payable 2827 DND
Albert Hsiang 2824
ison Winter 2065 Q
Andrew Mamkhao 2877
a Vaznuez 2984 Q
Narturo Montoya 2876
0 (C)  Attendant (..444 (C) | Image 3: The Directory Listing
Directory Area
» Each extension has 4 fields for:
- Firstname*
- Lastname*
- Ext*

Directory Area
» Each extension has 4 fields for:
- Firstname*
- Lastname*
- Ext*
- Status
- Green Dot (extension in use)

e ook |
Date mm dd ww [ Time bh [ mm | 7
Summary | |
Descivm [ aaa |
e | Image 4: Reminder/Notebook Section

- DND (do not disturb)
- OUT (extension not in service)
*These fields can be sorted on screen.

» Use this section to:
- Easily locate extensions, names and status
- Place internal call
- Leave a Voicemail
» Use this section to move active calls:
- Transfer-
- Announce (supervised) transfer
- Direct to Voicemail

Reminder/Notebook Area
» Use this section to:
- Store messages for the organization
- Make personal notes

5|




Menu Bar
Switchboard’s menu bar has six options (File, Edit, Call, Directory, Tool and Help)
which gives you access to pull-down menus.These entries control all aspects of the
application.
Note: Command options in the menus and the Toolbar will only be
highlighted or “live” when they are available and can be used in the
current situation.

1. The File Menu has controls for the reminder/notebook functions and permits
program exit.

Tod

Image 5: Drop-down File Menu

Command | Descri

Save reminder Saves the reminder entry

Save note book Saves the note book entry

Reset note book Clears the note book entry

Exit Closes the Switchboard Application

2. The Edit Menu provides standard cut, copy and paste functions and allows
preference changes.

Image 6: Drop-down Edit Menu

Command | Description
Cut Cuts selected text from the reminder/note book section
Copy Copies selected text in the reminder/note book section
Paste Sticks selected text into the reminder/note book section
Preferences Options for configuration, layout and colors.

(See page 13 for complete details.)
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3. The Call Menu gives options for a call: hold, transfer, forward, conference,
Voicemail and end.

Call Divectory  Tool Help
Hold for me:
Erd cal
Forward all cals to Autoattendant

Announce the caler
Transfer the cal
Voion mal

Hold for this person

Image 7: Drop-down Call Menu —

Command | Description | Keyboard Shortcuts
Hold for me Places the selected call on hold F1

End Call Ends the selected call F3

Forward all calls to Forwards all incoming calls to the | F9

Auto-Attendant Auto-Attendant

Call this person Places a call to the selected F7

directory entry

Leave voicemail Leaves a voicemail message for F5
the selected directory entry

Announce the caller Calls the selected person and F2
allows announcement of the
incoming call, while placing the
active call on hold

Transfer the call Transfers the call directly to the F4
selected directory entry

Voicemail Accesses the voicemail box None

Hold for this person Places an incoming call on hold None

for a selected directory entry

4. The Directory Menu assists in sorting the organization’s directory.

Call | Drectory  Tod  Help
Sort by First name

Sart by Last narme
Saork by Extergion

Image 8: Drop-down Directory Menu
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Command | Description

Sort by First name Changes the Company Directory to alphabetical ascending order,
based on the entry in the Firstname column. The Firstname
column will then appear first in the directory.

Sort by Last name Changes the Company Directory to alphabetical ascending order,
based on the entry in the Lastname column. The Lastname
column will then appear first in the directory.

Sort by Extension Changes the Company Directory to numeric ascending order,
based on the entry in the Ext. column. The directory will list
Lastname, Firstname, and Extension number across the screen.

5. The Tool Menu provides the ability to modify the appearance of the
Switchboard display window and to show or hide tool bar buttons.

[] *Metal Look & Fesl

toolbar b Motif Look e Feel
Directory toolbar +

Image 9: Drop-down Tool Menu

Command | Sub-Command | Description | Note
Look & Feel
Metal Look & Feel Changes background colors
Motif Look & Feel Changes background colors
Windows Look & Feel All borders and frames are Metal Look & Feel
the standard Windows color.
The text is the standard
Windows font color and style.
Call Toolbar
Show Shows the Call Toolbar The Toolbar buttons take
buttons above the Active up space at the top of the
Calls Area. screen. It may be
necessary to resize the
"Reminder/Notebook"
window to show all.
Hides Hides the Call Toolbar
buttons.
Directory Toolbar
Show Shows the Directory Toolbar
buttons above the Active
Calls Area.
Hides Hides the Directory Toolbar
buttons.




Bl Edt Col Drectory Todl ;
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Atenidant

=" Active calls
Image 10: Toolbars appear beneath the Menu Bar \\/

and above the Directory Area.

6. The Help Menu has application information and tips for problem solving.

Image 11: Drop-down Help Menu

Command | Description

About Switchboard Provides version details about the application.

Help Controls Opens a browser that contains troubleshooting information.

[conent: [

W switchboard Online Help
® Introduction

Switchboard

@ Connecting to Switchbosrd
® Managing Switchboard Calls

Online Help

Image 12: Online Help Version 4.2
Landing Page

Managing Active Calls

The Active Calls Area displays all active calls. A button appears on each call displayed,
giving the switchboard operator options to answer, hold, transfer or end it. These
incoming calls are listed top to bottom in order of appearance. In other words, the
most recent calls are displayed at the bottom of the caller list in the Active Calls Area.

Answering an Incoming Call
Incoming calls ring and appear on the computer screen as a button with a
telephone symbol.

(0 taosegrassd RN |
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To answer an incoming call:
1. Pick up the telephone receiver (if not using a headset)
2. Use the mouse to click on the incoming call’s button
3. The call becomes active
4. Speak into your phone handset or headset

0 ossETaSEA 0003

Placing and Retrieving a Call on Hold

Circumstances demand that some callers be placed on hold. If you answer an

incoming call while talking on another one, the first call will automatically be put on
hold.

5 SWITCHBOARD

File Edt Call Directory Tool Help

Active calls Directed hold

Image 13: An Incoming Call as it appears on the screen

To manually put a call on hold:
1. Click on the on-screen button for the call you want to hold
2. Click on the Call Menu
3. Select”Hold For Me”
4. The timer shows the length of the call being held.

Alternative manual methods:
a. Click on the on-screen button for the call you want to hold
b. b.Select the “Hold"” button on the Toolbar
Or
a. Right-click on the incoming call button to display the pop-up menu
b. Select“Hold For Me”
To retrieve a call on hold:
a. Click once on the on-screen button for the call on hold
Or
a. 1.Right-Click on the button to bring down a menu
b. 2.Select “Retrieve”

Transferring a Call
Transferring an incoming phone call is a common chore that can be done quickly and
easily via Switchboard.

To transfer a call:
1. Click on the on-screen button for the call you want to transfer
2. Move to the Directory and click on the individual who is to receive the call
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3.

Image 14: Transferringa
call using the drop-down Call Menu B

4.

Click on the Call menu

Call Drectory Tool Help
Hold far me:

tive erdesl

Eorward all calls to AutoAttendant

Announce the caller
Transfer the cal

Veice mal
Hold far this perean

Select “Transfer the Call”

Alternative transferring methods:

a. Click on the on-screen button of the call to transfer

b. Move to the Directory and click on the individual who is to receive
the call

c. Select the “Transfer” button on the Toolbar

Or

a. Click on the on-screen button of the call to transfer

b. Move to the Directory and click on the individual who is to receive
the call

c. Select“Transfer the Call”

When the switchboard operator transfers a call, the destination telephone rings
and operator’s telephone reverts to a dial tone in North America or a busy tone if
in Europe.

Announcing a Call

Announcing a call is done when the switchboard operator answers an incoming

call and the caller requests to be connected with someone or their extension.The
operator calls the requested individual’s extension to inform of the incoming call. Then
the call is transferred.

To announce a call:

1.

2.
3.
4.

If the call is not currently active, click on the on-screen button for the caller you
want to announce

Move to the Directory and click on the individual who is to receive the call
Click on the Call menu

Select “Announce the Caller”

Alternative announcing methods:

a. Click on the on-screen button of the call to transfer

b. Move to the Directory and click on the individual who is to receive the call
c. Select the “Announce” button on the Toolbar

Or

a. Click the screen button of the call to transfer
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b. Move to the Directory and click on the individual who is to receive the call
c. Select“Announce the Caller”
5. When the intended recipient answers, operator advises of the incoming call
6. Then right-click on the “Directed Hold" area button to display a pop-up menu
7. Click on“Transfer”

Both caller and recipient information will disappear from the Active Calls area.The
phone reverts to a dial tone in North America or a busy tone if in Europe.

Retrieving an Announced Call
You can continue a dialogue with the incoming caller, after having announced a call.
You do this by re-activating the incoming call before you make the final transfer.

To re-activate the incoming call:

1. Right-click on the incoming call button in the “Directed Hold” area to display a
pop-up menu

2. Select“Retrieve”

Or

» Simply click on the button directly and the incoming call will become active.
The recipient button will stay in the Active Calls area. The switchboard operator
can speak to either the caller or the recipient by clicking on their respective call
buttons in the “Active Calls” or “Directed Hold” columns. Transfer as instructed
above.

Transferring a Call Directly to Voicemail
Transferring an incoming caller directly to an individual’s or group’s mailbox is
simple.

To transfer a call to Voicemail, in the Active Calls area:
1. Click on the on-screen button for the call you want to transfer
2. Move to the Directory and click on the individual who is to receive the mes-
sage
3. Click on the Call menu
4. Select "Voicemail”
Alternative transferring methods:
a. Click on the on-screen button of the call to transfer
b. Move to the Directory and click on the individual who is to receive the
message
c. Select the “Voicemail” button on the Toolbar
Or
a. Click on the on-screen button of the call to transfer
b. Right-click on individual in the Directory who is to receive the message
c. Select”Voicemail”
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Making an Internal Call

To call within the organization, the simplest way is to:
1. In the Directory, double-click the name of the individual you want to contact
2. Your own telephone will ring
3. When you answer it, a button with a telephone icon will appear in the Active
Calls area on the computer screen

To call within the organization:
1. Click on the individual in the Directory you want to contact
Click on the Call menu
Select “Call This Person”
Your own telephone will ring
When you answer it, a button with a telephone icon will appear in the “Active
Calls” area on the computer screen (this screenshot would be more relevant if
the console section was shown).

s wN

|our Image 15: Using the Directory to make

an Internal Call

Leaving an Internal Message
To leave a message in an individual’s Voicemail box:
1. Click on the individual in the Directory you want to contact
2. Click on the Call menu
3. Select“Leave a Voicemail”
Holding a Call for a Person
To hold a call for a specific person, in the Active Calls area:
1. Click on the on-screen button for the call you want to place on hold
2. Move to the Directory and click on the individual who is to receive the call
3. Click on the Call menu
4. Select“Hold for this person”
Alternative method:
a. Click on the on-screen button of the call to place on hold
b. Move to the Directory and right-click on the individual to display the
pop-up menu
¢. Select“Hold for this person”
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5 SWITCHBOARD

File Edit Call Directory Tool Help

All calls directed to Auto Attendant

Image 16: Calls directed to the Auto Attendent

Activating the Auto-Attendant

Switchboard’s Auto-Attendant is the application’s advanced feature that will
automatically manage in-coming calls when the operator cannot be present or during
after-hours.

To activate the Auto-Attendant:
» Using the Call menu, select “Forward all calls to Auto-Attendant”
Alternative method:
a. Using the Toolbar, click on the “Auto-Attendant” button

Deactivating the Auto-Attendant

To deactivate the Auto-Attendant:
» Using the Call menu, select “Cancel forwarding to Auto-Attendant”
Alternative method:
a. Using the Toolbar, click off the “Auto-Attendant” button
When the Auto-Attendant is deactivated, the Active Calls area will revert to its
normal state.

Directed Hold

When a call is located in the “Directed hold” column, this indicates the caller has been
placed on hold by someone at an extension within the organization.The operator can
check on the caller if several minutes pass without a change in status.

Image 17: A Call in the Directed Hold Area

Preferences Window

You can change the appearance of your Switchboard to suit your own tastes and
way of working. Preference options are found under the Edit menu. After selecting
Preferences, you will find:

| 14



» Configuration options are set in the setup module, which is usually run only
once, when you are first configuring the application. You cannot change the
configuration from the preference window and are only shown for reference.
To change the configuration preferences, you will need to run the application
setup again. Refer to page 6 and the “Getting Started” section of this manual.

» Look & Feel options allow you to choose from three different designs for the
application window and let you show or hide the Toolbar buttons.

» Layout options allow you to define the size of the Directory and the
Reminder/Notebook windows, including the height of the rows. Narrower and
shorter columns and rows will allow for more extension listings and messages.
As an example the default value of the height of a row is 20 and can be scaled
down easily to 13 to permit more rows in the layout.

» Color options allow you to choose different shades for all the different areas
on the window display.To choose the color for any of the areas shown:

Image 19: Preference Window for Color

|
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Image 20: Select Color Window

1. Click anywhere in the color rectangle next to the object you want to change

2. Choose a color in the window that appears

» In Select color window, there are three different tabs that lead to windows,
which provide complete control over the colors of your screen layout.They are
Swatches, HSB (hue, saturation, brightness) and RGB (red, green, blue).

» The Swatches window provides about 270 different pre-set colors to choose
from.The most recently chosen colors are displayed in the Recent window on
the right.To choose a color:
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- Click on one of the predetermined colors in the main Swatches area
Or
1. Click on one of the recently used colors on the Recent area.
2. Click on the OK button on the Swatches window
3. Click on the OK button on the main color preferences window
» The HSB window uses a slider bar to choose a color. Here's how:
- Slide the bar up or down until the color is correct

1. Move the small white circle until the required mix is achieved

2. Click on the OK button on the HSB window

3. Click on the OK button on the main color preferences window

» The RGB window uses three slider bars to choose a color.There is one for each
of the colors, red green and blue:

1. Slide each bar to the right or left until the color area is correct

2. Click on the OK button on the RGB window

3. Click on the OK button on the main color preferences window

Resizing the Windows

You can resize the windows on Switchboard’s screen display. There are two main
window dividers. One separates the Active Calls area from the Reminder/Notebook
area below it. Another divider separates the Directory area from the two other areas.

To move either divider:
1. Move the mouse pointer over the divider and when it changes to a
double-headed arrow.
2. Click, hold and drag the divider to the required location.
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Miscellaneous System Numbers
The following numbers are to access different extensions not associated with
employees.

» 555:Voicemail: This is the internal number you call from your extension to
access Voicemail

» 556: Conference Bridge: The conference bridge is a reservation bridge that
users of the system can schedule conference bridges for internal and/or
external use.

» 444: Auto-Attendant: This is the internal number you could call or transfer a
caller to reach the Auto-Attendant allowing, menus including dial by name 1,
dial by extension 2, company directory 4, or 500 to reach Voicemail.This is also
the greeting someone will get when they call your company and someone
does not answer.

» 500: Access Voicemail: This number can be reached from the outside through
the attendant to access your Voicemail.

» 559: Company Voicemail and Auto-Attendant recording: Extension 559
changes require a system password. Default password will be 388045 it is
recommended that it is changed.

» 601-605: Park Extension Range: These numbers are used to park a call without
transferring it to a specific extension. A parked call can be picked up from any
extension phone on the system.
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WARNING

Toll fraud is committed when individuals unlawfully gain access to a customers
telecommunication system.This is a criminal offense. Currently, we do not know of
any telecommunications system that is immune to this type of criminal activity. 8x8
Inc.will not accept liability for any damages, including long distance charges, which
result from unauthorized and/or unlawful use. Although 8x8 Inc. has designed security
features into its products and services, it is your sole responsibility to use the security
features and to establish security practices within your organization, including
training, security awareness, and call auditing to eliminate security risks.

NOTICE

While every effort has been made to ensure accuracy, 8x8, Inc.will not be liable for
technical or editorial errors or omissions contained within the documentation.The
information contained in this documentation is subject to change without notice. This
documentation may be used only in accordance with the terms of the 8x8, Inc. License
Agreement.

8x8, Inc.
Contact Information
* Personal Web Page: http://www.8x8.com

Support:

* http://www.8x8.com/support

+ Customer Service, toll free: 1.888.898.8733

+ Customer Service, outside of the U.S.: 1.408.687.4120

The 8x8, Inc.logo are registered trademarks of 8x8, Inc.
8x8, Inc.is a Nasdaq listed company, symbol EGHT.
© 2009.8x8, Inc. All rights reserved. corp09209
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